
Contents
Help topics available for wcEvent are listed below. Use the scroll bar to see items that are not currently visible in the help 
window.
To learn how to use Help press the F1 key or choose Using Help from the Help menu.

wcEvent Application
Overview
Tips and Hints
Running WCX files from wcEvent 

System Functionality
Starting with command line
Automatic Save
System Menu Options
Drag and Drop
Remote Access
System Option Dialog
Batch File/Log File Editors

Application Interface
Menu Options
ToolBar Buttons
Accelerator Keys

Events
Definition
Adding
Editing
Enabling
Description Properties
Schedule Properties
Action Properties
Option Properties
Keys Properties
Duration Properties
Sending Key Strokes



Overview

What is wcEvent?
wcEvent is a versatile Windows application that runs programs automatically or displays a message at a specified time. wcEvent 
provides functionality such as: 
· automatic reschedule
· disable after execution
· log to file
· automatic save
· remote access and more.

How can wcEvent be used?
wcEvent is a scheduling utility with versatility as one of the top criteria during its development.
You can use wcEvent to handle those chores that need to be run, but are better run unattended to optimize your computer time. 
You can use wcEvent you to remind you of those routine chores by leaving message or reminding you by launching those 
applications used during your routine chores. Billing, Accounting, To Do List, Diary, Appointments.
wcEvent’s ability to save schedule files allows it to be used by multiple people on the same machine. 
You could also use wcEvent just as a convenient place to launch or favorite applications. Create events for your applications, 
Disable scheduling, and sort by description. You now have all or favorite application in one place and saved as your own file.
wcEvent's versatility is there for your needs and imagination.



Tips and Hints
This section contains information that might be helpful to you in setting up a running wcEvent. This information comes from many
sources such as commonly ask question from other users and tips shared with us from users. Also we try to include what 
knowledge we have about how wcEvent operates that might not be as fully described in the Help Topics.
Reschedule If Past Due Option
Enable Scheduling Menu Option
DOS Applications



Reschedule if past due

When would I use this option ?
Well consider this option when you have an event that you want to run regularly but it doesn't absolutely have to run. For 
example, I have a daily event that defragments my drive during my off hours. If for some reason this event became past due, it's 
not an event I consider to be absolutely needed everyday. So by selecting the Reschedule if Past Due option, the next time the 
application evaluates this event and finds it is past due it will not launch the event and interrupt my computer time, but will 
schedule it for the next day at its original time.



Enable Scheduling menu option
This menu option found in the System Menu is extremely useful for doing maintenance to your schedule file. By unchecking this 
option you can proceed with your maintenance without interruptions from scheduled events. After which check this option and 
your scheduling will resume normally.
One user has found this to be a favorite option. As a network administrator he maintains several schedule files throughout the 
network. By unchecking this option on his own copy of the application he is able to work on the files that are remotely running 
without having to deal with events that are currently launching from the remote sites.



DOS applications
Screen Savers prevent DOS Applications from running in the background. The application will become iconized and will wait 
there until the user opens that icon again at that time it will continue on with its operation. One way to avoid this problem is to use
a PIF file to run the application. In the pif file editor check the allow background processing and run in a window. This allows the 
application to act more like a window and continue its process. For more on PIF files see the windows help file.



Command line
The wcEvent application can be started loaded with a already existing schedule file. You accomplish this by passing the file path 
and name as a command line parameter. Example: < wcevent.exe c:\wc5\myfile.lpd >



Automatic save
When wcEvent is running unattended and operating normally, the schedule file is saved to disk each time an event is fired and 
rescheduled. This keeps the schedule file up to date at all times.



System menu items
System menu has several menu options for control of the wcEvent Application. Along with the normal menu options (minimize, 
maximize, size, move) are the following options used in the application.
· Menus - Allows you to toggle on and off the applications menu bar. When checked the application menu bar is visible. When

unchecked the menu bar is hidden.
· Enable Scheduling - This option allows you to globally enable and disable wcEvent's ability to launch events. When 

checked events can be launched, unchecked disables all events from launching.
· Always On Top - When checked wcEvent will stay visible on top of other application without interfering with the windows 

operations. This can be handy if you want to see your scheduler at all times.
· Close - Selecting this option will quits the application.
· Switch To - Will bring up the Window's Task Manager.



Drag and drop support
The wcEvent application supports drag and drop for adding events to the currently loaded wcEvent file. When you drag a valid 
program file and drop on the main window the application adds this program as a new event.

To add a program to the currently loaded schedule file
1 Click on a file in the Windows 3.1 File Manager
2 While holding down the mouse button, drag (move) the mouse pointer to the wcEvent window. If you've minimized wcEvent,

you can drag the files to the minimized icon.
3 Release the mouse button to drop the file.
To add multiple files to a schedule using Drag and Drop, select the desired files in the File Manager before dragging them to 

wcEvent.



Remote access
When wcEvent is running and the Auto Load Changes to Schedule is activated, wcEvent constantly monitors the original file that 
is loaded for any modifications. If it detects that this file has been changed it will reload the modified version.
This means that if you have remote access to the application, you can modify a schedule file you know is running, and the 
application which is running this file can pick up those changes.
Related Topics:
System Options Dialog



System option dialog box
System Option Dialog allows you to define options that effect wcEvent's main window and operation. It also allows you to select 
editors to be used for viewing and editing batch files and log files.
· In the Display section you can toggle off and on the Frequency column and the Next Scheduled column. If the box is 

checked then the column will appear in the main window with those details for each event. If not checked the column is not 
shown in the main window.

· Auto Load Changes to Schedule check box enables wcEvent's ability to receive changes from a remote access. When 
checked wcEvent monitors the original schedule file for changes. When changes are made to that file wcEvent will 
automatically load the changed file.

· Schedule Resolution is where you define in seconds how often wcEvent looks at the schedule for events ready to launch. 
What this means for example is that if you set this number to 10 for example, every 10 seconds wcEvent will look at the 
current schedule for events that need to run, and then sets idle until the next 10 seconds have passed. This allows you to 
maximize Window's processing time based on what best fits with your computing needs.

· The Log View/Editor you can define the editors that you want to use for viewing log files and the editor you want to use for 
editing bat files. By default Window's Notepad.Exe is used for the editor. You can though select any editor you have 
available. You can defined one editor for viewing log files and a different editor for editing batch files. The push buttons will 
bring up a path and file selection box to help you find the editor you wish to use. These selection will be saved in the 
desktop file when you exit the application, and will be available the next time you start wcEvent.

Related Topics:
Remote Access
View the Log File



File | View the log file
This menu option will allow you to view any log files that are associated with the currently load event schedule. When selected 
the application will search all the events for any log files that have been defined, as part of the event options. If more than one 
log file is defined, a selection box will appear and you will be able to choose the file you want to view. If only one log file is 
defined the file will be loaded automatically in the editor you have defined in the system options dialog.
Equivalent Toolbar button. <None>
Related Topics:
System Options
Options Properties



Options Properties
· Enable The Event -- Check this box to activate this event. When unchecked the Disabled label shows in the main window.
· Audible alarm -- Check this box if you want the event to Beep when it runs.
· Log To File -- Check this box if you want the date, time and description to be written to a log file when it runs. When this 

option is checked a box will appear and allow you to define the file name you wish the event to log to.
· Prompt Before Execution -- Checking this box the event will notify you before running. You have the chance here to stop the

event if you desire and the event will be rescheduled normally.
· Execute If Past Due - Check this option if you want wcEvent to run this event even if it is past due. This comes in handy 

when wcEvent is not always running.
· Re-Schedule if Past Due - Check this option if you want wcEvent to reschedule an event if past due without launching the 

event.
· Delete After Execution -- Checking this option will delete the event after it has run from the scheduler file.
· Disable After Execution -- Checking this option will disable the event after it runs. This is equivalent to a One Time 

Frequency.
· Suspend Schedule Until After Execution -- This option will stop the application from launching any other event until this 

event is completed. (the application has quit). Currently this option is only effective with Window Applications. Running a 
DOS application or PIF file will not stop the application from running the next event.

Related Topics:
Edit Dialog Buttons
Tips and Hints



Edit dialog buttons
The five buttons on the right side of the edit dialog box operate the same for all four tab dialog screens.
· Previous -- This button will bring to the front the previous tab dialog screen. For example, if you are in the "Description" tab 

dialog screen and press this button the "Options" tab dialog screen will be brought to the front..
· Next -- This button will bring to the front the next tab dialog screen. For example, if you are in the "Description" tab dialog 

screen and press this button the "Schedule" tab dialog screen will be brought to the front.
· OK -- This button will close the Edit Dialog Box and implement any changes that have been done to the event that was 

being edited.
· Cancel -- This button can be used if you want to disregard any changes that have been made. This button will close the edit

dialog box and return the event to its previous state. If adding an event the event will not be added.
· Help -- This button will get you the help file on whichever tab dialog screen that is currently on top.
Related Topics:
Action Properties
Description Properties
Option Properties
Schedule Properties



Action properties
· Here you define the type of event you desire. By default the Run Program button is selected. The following describes the 

available options.
· Run Program - Select this option if the event is to run a valid program.
· Display Message - Event will display message to the screen, When you select this option a area to type the message to be 

displayed will become visible.
· Exit Windows - This option will shut down windows and return to the DOS environment. Note that if any program running 

requires confirmation before exiting at the time this event is launched, you will need to handle manually.
· Restart Windows - This option will shut down Windows and then restart Windows normally. Note that if any program running

requires confirmation before exiting at the time this event is launched, you will need to handle manually.
· Reboot System - This option will perform a complete reboot of the computer. The computer will reboot normally. This would 

be the same as shutting down Windows and using the Ctrl+Alt+Del Keys.
Related Topics:
Edit Dialog Buttons



Description properties
· Description -- This is the text you input to describe the event. This text is shown in the main window in the description 

column.
· Command Line -- This is the actual program name to be run. This could be any valid *.exe, *.pif, *. bat, *.com file name. 

This should include the drive and path. You can press the folder button to the right of this control to use the standard select 
file dialog box to select the file.

If the event is a batch file you can use the edit button to the right to edit that batch file. Pressing the edit button will launch the 
editor that is defined in the system options dialog with the batch file. You can then edit and save the file and continue on with 
defining your event.
· Working Directory -- Working Directory is the directory where the executable finds associated files that are required to run 

the program. (Most programs do not require an entry in this field. occasionally however, a program will refuse to run 
properly unless it is specifically told where to find other program files.) wcEvent will change to this directory when running 
the event. You can press the button to the right of this control to use the standard select file dialog box to select the 
directory.

· Run Style -- Here you select how the program is to be started. maximized, minimized, normal and DOS. For more 
information on the different styles see "Run Styles".

· Test Button -- Can be used to test the event and return to this dialog box.
Related Topics:
Edit Dialog Buttons
Run Styles



Run styles
The different run styles available in the event edit dialog are defined below.
· Normal - For window programs will be launched in what ever manner is normal for this application. If the application 

normally launches in a less than maximized window it will be launched this way.
· Minimized - This option will launch the event in a icon state.
· Maximized - This option will launch the event in a full window.
· DOS - This option will quit windows, and launch the desired application in the DOS environment. When the event is 

completed Windows will be restarted.
Related Topics:
Description Properties



Schedule properties
· Frequency -- Here you have the ability to select at what interval this event will run. The options here are One Time, Hourly, 

Daily, Weekly, weekdays, weekends. Monthly, Yearly and Interval (By selecting interval you'll see the additional controls that
effect this frequency option. 

If the event is enabled the select option is visible in the main window.
· Date -- Here you type the first date you want the event to run. The application will not allow a invalid date such as 1/32/95. 

The required format is mm/dd/yy. While on this control there are some quick keys to help in setting the date. The "PgUp" 
and "PgDn" keys can increment the month and the "+" and the "-" keys can increment the days. Also by clicking the date 
button to the right will bring up the point and click calendar.

· Time -- Here you type the first time you want the event to run. The required format is hh/mm/ss AM/PM. There are also 
some quick keys to help in setting the time. The "PgUp" and "PgDn" keys can increment the minutes while the "+" and the 
"-" keys can increment the seconds.

Related Topics:
Edit Dialog Buttons



File editing
The application provides quick access for viewing and editing batch files and log files. You can specify the editor or editors of 
choice in the system options dialog. When an event is a batch file you'll be able to access that file from the command line edit 
box where you define the command line. This comes in handy when testing and when modification are needed. Log files can be 
viewed by selecting the View Log File option in the file menu. The application will search all the events for defined log files and 
present you with a list to choose from. If only one log file is defined it will automatically open using the editor of choice.
Related Topics:
Viewing Log Files
System Options
Description Properties



Menu options

File -- Options for handling all file operations
New
Open
Close
Save
Save As
View the Log Files

Events -- Options for handling all event operations
Add
Edit
Copy
Delete
Enable Event
Information
Set Event Defaults
Auto Launch
Launch
Re-Schedule

Options -- Options for handling available system operations
Sort by Description
Sort by Schedule
Sort by Frequency
Fonts
Status Bar
Control Bar
Label Bar
Save Settings On Exit
Save Settings Now
System Options

Help -- available help options
Contents
Using Help
About wcEvent



File | New
This option will close the current wcEvent file and clear the main window. The Application is now ready to create a new file. You 
can start a new file by adding a new event.
Equivalent toolbar button, <None>
Related Topics:
Adding Events



Adding events
wcEvent gives you four ways to add an event to the current File.
· The Menu option Add... found under the Event menu option.
· The Add button on the toolbar.
· The Drag and Drop functionality is also supported.
· Using the Accelerator key <INS>
Using one of these methods will bring up the event edit dialog box. Allowing you to start a new event. After you complete defining
the event's properties and press the OK button the event will be added to the main window. If you decide to use the cancel 
button from the dialog button then this event will not be added to the main window.
Related Topics:
Description Properties
Schedule Properties
Action Properties
Option Properties
Keys Properties



Keys properties
· Send Keys - This check box determine whether or not the send key property is enabled for the current event.
· Delay - Enter here the amount of time that wcEvent will pause before sending the Key strokes.
· Keys to Send - You use the area to define the actual key strokes to send as part of this event. For more information see 

"Sending Keystrokes".
Related Topics:
Event Edit Buttons
Sending Keystrokes



Send keys option
You can define a series of keystrokes to automatically send as part of the event. You define this in the "Keys" section of the 
event edit box.
Each key is represented by one or more characters. To specify a single keyboard character, use the character itself. For 
example, to represent the letter A, use A for key text. If you want to represent more than one character, append each additional 
character to the one preceding it. To represent the letters A, B, and C, use ABC for key text. The plus sign (+), caret (^), percent 
sign (%), tilde (~), and parentheses ( ) have special meanings to SendKeys. To specify one of these characters, enclose it inside 
braces. For example, to specify the plus sign, use {+}. Brackets ([ ]) have no special meaning to SendKeys, but you must 
enclose them in braces as well, because in other applications for Microsoft Windows, brackets do have special meaning that 
may be significant when dynamic data exchange (DDE) occurs. To send brace characters, use {{} and {}}.To specify characters 
that aren't displayed when you press a key (such as Enter or Tab) and keys that represent actions rather than characters, use 
the key codes defined in the SendKeys Codes.
Key Codes
To specify keys combined with any combination of Shift, Ctrl, and Alt keys, precede the regular key code with one or more of the 
following codes:
Key                           Code  
Shift +
Control ^
Alt %
To specify that Shift, Ctrl, and/or Alt should be held down while several other keys are pressed, enclose the keys' code in 
parentheses. For example, to have the Shift key held down while E and C are pressed, use "+(EC)". To have Shift held down 
while E is pressed, followed by C being pressed without Shift, use "+EC".
To specify repeating keys, use the form {key number}; you must put a space between key and number. For example, {LEFT 42} 
means press the Left Arrow key 42 times; {h 10} means press h 10 times.
Along with the SendKeys defined in the Key Codes there are the following special commands that can be sent as SendKeys. 
The syntax for sending these commands is the same as above the command needs to be within the braces.
i.e . {Delay}.
· Delay - This command will wait a determine time before sending the next key to the event. You specify the time in 

milliseconds following the command. For example {Delay 1000} will wait 1 second before execution of the next key.
· Date - This command will send the current date as text. You can also define date math following the command. For example

{Date 1} will send tomorrow's date, {Date -1} would send yesterday's date. You must leave a space between the command 
and the number.

· Time - The Time command sends the current time as text. You can also do math on this function by defining the amount of 
seconds after the time command. For Example {Time 60} would send the current time + one minute and {Time -60} would 
send the current time minus one minute..

· Day - The day command will send the numeric value for the day of the current date. You can also do math on this function 
by defining the amount of days after the command. For example {Day 1 } would add one the current day and Day -1 would 
subtract 1 day.

· Month - The month command will send the numeric value for the month of the current date. You can also do math on this 
function by defining the amount of months after the command. For example {Month 1} would add one the current month.

· Year - The Year command will send the numeric value for the Year of the current date. You can also do math on this 
function by defining the amount of Years after the command. For example {Year 1} would add one the current year.

· Hour - The Hour command ill send the numeric value for the current hour. You can also do math on this function by defining 
the amount of hours after the command. For example {Hour 1} would add one hour {Hour -1} would subtract a hour.

· Minute - The Minute command ill send the numeric value for the current minutes. You can also do math on this function by 
defining the amount of minutes after the command. For example {Minute 1} would add one minutes {Minute -1} would 
subtract a minutes.

· Second - The Second command ill send the numeric value for the current second. You can also do math on this function by 
defining the amount of seconds after the command. For example {Second 1} would add one second {Second -1} would 
subtract a second.



Key codes
Key Code
Shift +
Control ^
Alt %

BackSpace {BKSP}
Break {BREAK}
Caps Lock {CAPSLOCK}
Clear {CLEAR}
Del {DELETE}
Down Arrow {DOWN}
End {END}
Enter {ENTER} or ~
Esc {ESC}
Help {HELP}
Home {HOME}
Ins {INSERT}
Left Arrow {LEFT}
Num Lock {NUMLOCK}
Page Down {PGDN}
Page Up {PGUP}
Print Screen {PRTSC}
Right Arrow {RIGHT}
Scroll Lock {SCROLLLOCK}
Tab {TAB}
Up Arrow {UP}
F1 {F1} F2 {F2}
F3 {F3} F4 {F4}
F5 {F5} F6 {F6}
F7 {F7} F8 {F8}
F9 {F9 F10 {F10}
F11 {F11} F12 {F12}
F13 {F13} F14 {F14}
F15 {F15} F16 {F16}



File | Open
This menu option will allow you to open a existing wcEvent File. The Application will bring up the open file dialog box with the 
default extension. You can select different drives, and directories from this dialog box. If you select a new file wcEvent with save 
and close the current file and open the one you selected.



File | Close
This menu option will save and close the currently opened wcEvent file and clear the main window list box. At this point you can 
either start a new wcEvent file or open a existing Scheduler file.



File | Save
This menu option will save the current wcEvent file. If the current file has not been previously saved, the application will bring up 
the Save As dialog box. From this dialog box you will be given the opportunity to name the file and the drive and directory to save
to. Previously saved files are saved under its current file name.



File | Save as
This menu option brings up the Save As dialog box and allows you to name and save the current wcEvent file. You can specify 
the drive, directory, and name for the file. This option is automatically called if the current file has not been previously saved and 
you select the close option or quit the application.



File | Delete
This menu option quits the application. If there are changes made to the currently opened wcEvent file the application will bring 
up a message box and prompt you Do you want to save the current file. If you select yes then the appropriate actions for saving 
a file will be called.



Event | Add
This is one of the available methods for adding a new event to the current wcEvent file.
Related Topics:
Adding Events



Event | Edit
This is one of the available ways to edit the currently highlighted event. To get more information see Editing Events.
Related Topics:
Editing Events



Editing events
There are several ways to edit an event from the current scheduler file, 
· The Menu option Edit... in the Event pull down.
· The Edit button on the toolbar.
· Double clicking the left mouse button over the currently highlighted event.
· Pressing the <Enter> key for the currently highlighted event.
Using one of these methods mentioned above will bring up the event edit dialog box. From this dialog box you will be able to 
redefine any of the Event's properties. After you complete the changes you can use the OK button from the dialog box to save 
the changes you made. If you change your mind to any changes use the cancel button to return the Event's properties to their 
previous state.
Whenever you are in the event edit box the application is disabled and does not run any events until you close the edit box. 
Any time changes are made to any event, the application then recognizes that a save is needed when you either close the 
current Scheduler file or quit the application and will prompt you for a save. 
Related Topics:
Description Properties
Schedule Properties
Action Properties
Option Properties
Keys Properties
Edit Dialog Buttons



Event | Copy
This option will create a new event and fill the events properties with the properties of the currently highlighted event in the main 
window. The Event edit dialog with be brought up with for the new event. If you select OK from the event edit dialog the new 
event is then added to the main window and current wcEvent file.



Event | Delete
This option will remove the currently selected event from the main window. The application will then redraw the main window.



Event | Enable event
This menu option is one of the methods to toggle an event from enabled and disabled. 
Related Topics:
Enabling Events



Enabling events
There are four ways for enabling and disabling an event in the current wcEvent file.
· Menu option Enable Event found in the Event pull down.
· The Enable button on the toolbar.
· The event edit dialog box under options
· Accelerator key <CTRL+E>
You can use either of the two methods above to toggle the currently highlighted event in the main window. In the Frequency 
column in the main window you can determine the status of each event. When an event is enabled the frequency column 
displays the frequency for that event. When the event is disabled the frequency column will display "disabled".
When an event is toggled the event has been changed which tells the application that a save is required when you either close 
the current Scheduler file or quit the application.
Related Topics:
Option Properties



Event | Information
This menu option is one of the ways to see the latest information for the currently selected event. For more information see 
related topic.
Related Topics:
Event Information Dialog



Event Information dialog
This dialog box provides information for the currently highlighted event in the main window. There are several different items of 
information provided here.
· Description -- This is the description displayed in the main window.
· Working Directory -- This is the directory define in the description properties edit screen.
· Command Line -- Defined in the description properties edit screen.
· Last Scheduled -- This is the last known scheduled time before the application rescheduled this event. This is the only place

this information is found.
· Next Scheduled -- This is the date and time for this event to be run.
· Last Executed -- This is the actual date and time the application ran this event automatically. This date and time may not be 

identical to the last scheduled information because of any number of reasons. This information can only be found in this 
dialog box.

· Frequency -- This is how often this event is scheduled to be run.



Event | Set event defaults
This menu option allows you to define a default event. After which each time you add an event to the current file the add dialog 
will start with those default values in place. For example if you normally add messages to wcEvent and normally delete those 
messages after execution, you can set your default to be already set the Action to "Message" and the "Delete After Execution" 
option checked. All of the options provided for an event can be predefined here.
Related Topics:
Events



Events
An event is a message you wish to display or a program you want to run at a certain time at a certain frequency. Each event has 
a set of properties such as description, options, frequency, time etc.
For more information on actions available by this application select one of the following topics.
Related Topics:
Adding Events
Editing Events
Enabling Events
Event Information Dialog



Event | Auto launch
This menu option will launch the currently selected event now. When this option is used all events options are implemented. The 
event will update its schedule log to file etc. Unlike the "Launch" menu item that does not implement event options and 
reschedule. This option is handy for launching an event without having to edit the events schedule.
Event|Launch



Event | Launch
This option will run or display the currently highlighted event. Use this option when testing an event or when you just want to run 
an event now. When using the launch command the events next schedule date is not updated. Also none of the events 
properties such as logging to file, disabled after execution, prompt before executions, etc. are enabled when using this option.



Event | Reschedule
If an event's options are not set for reschedule if pass due or run if pass due, and this event is current pass due. This menu 
option can be used to quickly re-schedule the event for the next scheduled time without having to edit the event.



Options | Sort by description
Selecting this menu option will sort the events in the main window by the description. This does not effect in any way the actual 
schedule for the event. The events will still launch at its defined time. wcEvent will save the last known sort option when you quit 
the application. 
Related Topics:
Select Sort from Label Bar



Sort from label bar
You can select your sort option by clicking on the label bar over the desired label. i.e "Description". This performs the same 
action as selecting the sort option from the menu.



Options | Sort by schedule
Selecting this menu option will sort the events in the main window in by the actual scheduled date and time. After an event has 
rescheduled due to running, the application will repaint the main window maintaining the correct sort option. wcEvent will save 
the last known sort option when you quit the application. 
Related Topics:
Select Sort from Label Bar



Options | Sort by frequency
Selecting this menu option will sort the events in the main window in by the frequency . This does not effect in any way the actual
schedule for the event. The events will still launch at its defined time. After an event has rescheduled due to running, the 
application will repaint the main window maintaining the correct sort option. wcEvent will save the last known sort option when 
you quit the application. 
Related Topics:
Select Sort from Label Bar



Options | Fonts
This option will allow to select the font and size you wish to use in the main window for the event list. Selecting this option will 
bring up the standard Windows Font Select Dialog Box. From this box you can select the any font and size your computer 
currently supports. Also you can select the style of font as well. wcEvent will save the selection each time you quit the application
which enables wcEvent to select your previous options the next time you run the program.



Options | Status bar
The Application allows you to select whether or not the status bar at the bottom of the main window is visible. The application will
save the current state of this option each time you quit the application, and return the last known state the next time you run this 
application.



Options | Control bar
The Application allows you to select whether or not the control bar at the top of the main window is visible. The application will 
save the current state of this option whenever you quit the application and return the last known state the next time you run this 
program. For information on the available control bar buttons see "Control Bar Buttons".
Related Topics:
Control Bar Buttons



Toolbar buttons
When the menu option "Control Bar" is checked and the Control bar is visible in the application, these buttons are enabled. Click 
on the button that you want help information on.



Options | Label bar
The Application allows you to select whether or not the label bar at the top of the main window is visible. The application will save
the current state of this option each time you quit the application, and return the last known state the next time you run this 
application.



Options | Save settings on exit
When this option is checked the application will save all of the status of the toggled options, size of the windows, and the position
of the main window when you quit the application. If this option is unchecked when you quit the application, the next time you 
start the application wcEvent will use whatever settings were saved previously.



Options | Save settings now
Selecting this menu option will force a save of the system file items such as the status of the toggle options, screen size and 
position, as they are at this time.



Options | System options
Selecting this menu option will bring the system option dialog box which will allow you to define options that effect wcEvent's 
main window layout as well as its operation. For more details see "System Options Dialog"
Related Topics:
System Options Dialog



Help | Contents
The option opens the help file and places you on the Content page.



Help | Using help
Brings up the instruction for Microsoft Help.



Help | About
This option brings up the Application's About box which will display the currently running version of wcEvent.



Accelerator keys
wcEvent provides several accelerator (short cut) keys allows you to easily navigate through the application. The following is a list
of all accelerator keys available.
Key Definitions
Alt+F4 Exit Application 
Ctrl+Esc Switches between running applications
F1 Help
Ctrl+N Create a new wcEvent file
Ctrl+O Open existing wcEvent file
Ctrl+L Close current wcEvent file
Ctrl+S Save current wcEvent file
Ctrl+A Calls the save as dialog box
Ctrl+V Opens the log file Viewer/Editor
Ins Add new event to current file
Enter Edit currently highlighted event
Alt+Enter Auto Launches highlighted event
Ctrl+Enter Launch currently highlighted event
Ctrl+Y Copies currently selected event
Del Deletes currently selected event
Ctrl+E Enables or Disable currently selected event
Ctrl+ Bring up Information dialog for currently selected event
Ctrl+F Allows you to set the default options for an event
Ctrl+R Re-Schedules a past due event



Duration properties
Here you can define how long to continue to run an event. By default an event is defined to execute indefinitely. By deselecting 
this option you can defined a date and time that this event should quit executing. The event will run normally from its scheduled 
date and time until the date and time specified here.



Add button
This is one of the available methods for adding a new event to the current wcEvent file.
Equivalent Menu Option. <Event|Add>
Related Topics:
Adding Events



Button help
You can get a short description of a button's function by running the mouse over the top of a button on the toolbar. This message
is also displayed in the status bar at the same time.



Calendar control



Copy button
This button will create a new event and fill the events properties with the properties of the currently highlighted event in the main 
window. The event edit dialog will be brought up with the new event. If you select OK from the event edit dialog the new event is 
then added to the main window and current wcEvent file.
Equivalent Menu Option: <Event|Copy>
Related Topics:
Editing Events



Delete button
This button will remove the currently selected event from the main window. The application will then redraw the main window.
Equivalent Menu Option. <Event|Delete>



Edit button
This will open the event edit dialog for the currently highlighted event. To get more information see Editing Events.
Equivalent Menu Option. <Event|Edit>
Related Topics:
Editing Events



Enable button
This button is one of the methods to toggle an event from enabled and disabled. 
Equivalent Menu Option. <Event|Enable>
Related Topics:
Enabling Events



Help button
This button will open the application help file.
Equivalent Menu Option. <Help|Content>



Information button
This button will bring up the event information dialog box. For more information see Event Information.
Equivalent Menu Option. <Event|Information>
Related Topics:
Event Information Dialog



Interval frequency
When the frequency is interval you'll have the ability to specify at what frequency you want a reoccurring event to launch. You'll 
be able to specify whether the interval is in minutes, hours, or days). Also you will be able to select from two options as to how 
you want launch to reschedule the event. The reschechule from Completion Time option will maintain the interval between each 
launch. For example if the event is scheduled for 8:00am at 2 minute intervals and it runs at 8:01:00 am the next schedule would 
be 8:03 am, maintaining 2 minutes between events. If the reschedule from schedule time option is selected the event will 
reschedule from the scheduled time regardless of when it last launch. For example our 8:00 am event with 2 minute intervals that
launched a 8:01 would be rescheduled for 8:02 am.



Launch button
This button will run or display the currently highlighted event. Use this option when testing an event or when you just want to run 
an event now. When using the launch command the events next schedule date is not updated. Also none of the events 
properties such as logging to file, disabled after execution, prompt before executions, etc... are enabled when using this option.
Equivalent Menu Option. <Event|Launch>



Open button
This button will allow you to open a existing wcEvent File. The Application will bring up the open file dialog box with the default 
extension. You can select different drives, and directories from this dialog box. If you select a new file wcEvent with save and 
close the current wcEvent file and open the one you selected.
Equivalent Menu Option. <File|Open>



Save button
This button will save the current wcEvent file. If the current file has not been previously saved, the application will bring up the 
Save As dialog box. From this dialog box you will be given the opportunity to name the file and the drive and directory to save to. 
Previously saved files are saved under its current file name.
Equivalent Menu Option. <File|Save>



Toolbar position button
The button allows you to change the position and direction of the Toolbar. You can move the toolbar to the top, left or right side of
the window. wcEvent will save the position of the toolbar when you quit.



Running WCX files from wcEvent
To run wcCode programs (wcx files) from wcEvent, you must set up an association in Windows for wcx files, using wcRun as the 
application to launch.

To add an association in Windows 95:
· Open the My Computer or Windows Explorer application.
· Click the View menu, and then click Options.
· Click the File Types tab.
· In the list of file types, click the one you want to change. The settings for that file type are shown in the File Type Details 

box.
· Click Edit, then in the Actions box, click Open.
· Click Edit, then specify WCRUN.EXE as the program to use to open files that have this extension.
· In the Action type window, specify /R as the action to perform. This command line switch is required.
Note that any of these applications that are associated with file types must be in your path or your WILDCAT home directory 
(normally C:\WC5).
To add an association in Windows NT:
· Open the File Manager application.
· Select a file that has the extension you want to associate.
· Open the File menu, then click Associate. The filename extension of the file you selected appears in the Files With 

Extension box. 
· To associate the extension with a file type, type the program name WCRUN.EXE in the Associate With box, or use the 

Browse button to search for a program name. Specify /R as the action to perform. This command line switch is required.




